Instructions and Guidelines for Formatting a Thesis or Dissertation

Updated February 2012
Table of Contents

1. Requirements and Guidelines for Completing Graduate Theses and Dissertations ....................3
2. Formatting the Thesis or Dissertation: Sequencing of Pages .....................................................4
3. Detailed Descriptions of Various Required Thesis or Dissertation Components ......................5
4. Submitting the Thesis or Dissertation to the Office of Instruction & Graduate Studies
   (OI&GS) ........................................................................................................................................6
5. Bindery Form ...................................................................................................................................8
6. Manuscript Format or Internship Report (approved by individual departments) .....................9
7. Bibliography or References .......................................................................................................10
   Sample Format ...............................................................................................................................12
1. Requirements and Guidelines for Completing Graduate Theses and Dissertations

The following are ESF requirements and guidelines for preparing and submitting theses and dissertations. Individual departments may have additional requirements. It is recommended that the student consult with the department and/or major professor regarding the proper guidelines.

The general style manual for the College is **Council of Science Editors Style Manual**, available in the reference area of Moon Library and at the Reference Desk of Bird Library. A department may opt to use a style manual that is more discipline-oriented, and in doing so, accepts the responsibility of communicating this preference along with any other special requirements to the graduate students concerned. It is the student's responsibility to be aware of the style manual and any special requirements of the department. The document should state the style manual that is being used, if other than **Council of Science Editors**. Be sure to use this style during document preparation; simply because the style is different or unfamiliar does not mean this point can be ignored.

The College participates in a Thesis/Dissertation Information Service provided by ProQuest Learning Services. All master's theses and doctoral dissertations are submitted for inclusion in this database, which is a computerized index containing bibliographic citations to more than one million doctoral dissertations and master's theses dating back to 1861. This is a valuable resource because it makes available through a variety of products the results of students' work. Concurrent with submitting unbound copies of the documents to the Office of Instruction & Graduate Studies (OIGS), students are required to convert the documents to PDF format using Adobe Acrobat. Students then create an account on the ProQuest website, upload the PDF copy, complete information forms, and choose between two submission options:

- **Traditional Publishing**
  - Your work will be made widely accessible and you will be eligible to receive royalties; however, others accessing your work will be charged a fee.
  - There is NO fee to the student associated with this option to ProQuest or SUNY ESF.

- **Open Access Publishing**
  - Provides free global access to an electronic copy of your work via the internet.
  - You will not be eligible for royalties.
  - There IS a fee of $95.00 associated with this option; SUNY ESF does NOT pay this fee.

You must complete all information forms and pay any associated processing fee directly to ProQuest via the web-based process. This processing fee is separate from the binding fees associated with having the thesis/dissertation bound through the OIGS, and all costs are incurred by the student. The URL for submission of theses and dissertations is: [http://dissertations.umi.com/esf](http://dissertations.umi.com/esf). OIGS will verify that the version submitted online matches the signed, paper copies delivered to the OIGS office and approve the on-line submission. If the on-line submission differs from the signed hard copies, it will be rejected by OIGS and the student must resubmit the appropriate version.

To ensure the uniform physical quality of theses and dissertations, all will conform to the guidance provided by ProQuest at the ProQuest site.
2. Formatting the Thesis or Dissertation: Sequencing of Pages:

Front Matter:
Front matter is the “preliminary” parts of the thesis or dissertation, including the Title Page, Table of Contents, Lists of Tables, and Figures, etc. Each of these pages is numbered using lower case Roman numerals, (for example, i, ii, iii, iv, v, vi, etc.), Each page is accounted for in the running total, however, a number is not always visibly shown on all front matter pages. The following is a list of typical front matter pages included in theses and dissertations here at ESF:

- **Title Page** (Counts as Roman Numeral “i” – the page number does not appear on this page)
- **Copyright-optional** (Counts as Roman Numeral “ii” -- the page number does not appear on this page)
- **Acknowledgments- optional** (page numbering does appear on this page as either ii or iii, depending on whether Copyright page is included)
- **Table of Contents** (Depending on whether copyright page and or acknowledgment page is included, it should appear as Roman Numeral “ii,” “iii,” or “iv;” and it must be included on the page)
- **List of Tables** (Roman Numeral number must appear on page)
- **List of Figures** (Roman Numeral number must appear on page)
- **List of Appendices optional** (Roman Numeral number must appear on page)
  - Use only if document contains multiple appendices
- **Abstract with Key Words and Advisor Signature** (Roman Numeral number must appear on page)

Body:
The “body” of the thesis or dissertation is comprised of the various chapters of text. Here the pagination changes to the use of more familiar Arabic numerals (i.e. 1,2,3, etc.). Switch to Arabic numbering, starting with page 1; a page number must appear on this page if there is any substantive text; if the first page of the body only includes a chapter name or part designation with no substantive text, the visible numbering may begin on the following page with “2”). Reference this helpful video for tips on breaking up pages and page number conventions in Microsoft Word:

http://www.youtube.com/watch?v=NGzz2ZmLrFw

The following are traditional components of the body to be included in theses or dissertations at ESF:

- Introduction
- Literature Review
- Models and Materials
- Results
- Discussion
- Conclusions

Back Matter:
The “back matter” is the material following and supporting the main body or text of the thesis or dissertation. Pagination for the back matter remains in sequence and style with the body using Arabic numerals. Following are traditional components of the back matter to be included in theses or dissertations at ESF:

- Reference list or Bibliography
- Appendices
- **Resume or Vita** (This is the last page of the document and should include the last Arabic page number)
3. Detailed Descriptions of Various Required Thesis or Dissertation Components

**Title Page.** The “Title Page” should remain unnumbered, and all the rest of the front matter, with the exception of the copyright page and or acknowledgements page, should be numbered in lower-case Roman numerals, at the bottom right-hand margin. The student is considered the author of any thesis or dissertation and as such only the student's name shall appear on the title page. It is the student’s responsibility to obtain the signatures of the Major Professor (or co-Major Professors, where applicable), the Department Chairperson or Graduate Coordinator, and the Chair of the Examining Committee on all copies of the title page (see Sample Format on page 12). The names of each individual should be typed below the signature line for easy identification and future reference. Students in the Division of Engineering must also obtain the signature of the Director of the Division of Engineering. The signed copies of the title page should be submitted separate from the main text. The Dean of Instruction and Graduate Studies, S. Scott Shannon, will sign the title page after the copies are submitted to the Office of Instruction and Graduate Studies. All title page signatures, even for multiple copies, must be original signatures and must be obtained BY THE STUDENT (except for the signature of S. Scott Shannon).

Note: The date listed on the title page should be the month and year in which the document was successfully defended. For example, if the defense is April 12, 2012, the date on the title page should be April 2012. The year of degree conferral will be the year listed on the binding, which in some cases may differ from the year of defense (i.e, a student who defended in December but did not meet all degree requirements to graduate until the following semester, in the next year).

**Copyright Notice (optional).** The Copyright Act of 1989 does not require that published works carry a copyright notice in order to secure copyright protection. Nevertheless, most publishers continue to carry the notice to discourage infringement. Do not reference in Table of Contents (see Sample Format on page 15).

**Acknowledgements (optional).** When the author feels that acknowledgements are necessary, it should be remembered that brevity is a virtue. Do not reference in Table of Contents. This appears after the title page or Copyright page if Copyright page is included in the document.

**Table of Contents.** The wording of the chapter titles and all subheadings should exactly follow the wording within the body of the paper. Omit underlining in the Table of Contents. Period leaders between headings and page numbers should be used. All page numbers must be aligned to the right of the page. Set up Table of Contents using Word to ensure alignment and proper page numbering. The Table of Contents should not list the content on any pages preceding it (i.e., title page, copyright notice, acknowledgements).

**List of Tables.** Following the Table of Contents, the wording of the List of Tables should follow the exact formatting within the body of the paper. Omit underlining in the List of Tables. Period leaders between headings and page numbers should be used. The List of Tables and List of Figures should be on separate pages.

**List of Figures.** Following the List of Tables, the wording of the List of Figures should follow the exact formatting within the body of the paper. Omit underlining in the List of Tables. Period leaders between headings and page numbers should be used.
**List of Appendices.** Following the List of Figures, the wording of the List of Appendices should follow the exact formatting within the body of the paper. Omit underlining in the List of Appendices. Period leaders between headings and page numbers should be used. A List of Appendices is only appropriate when the document contains multiple appendices.

**Abstract with Signature and Key Words.** The abstract summarizes a thesis or dissertation. The abstract page is required and will contain key words listed a few lines below the abstract. Abstracts are bound with the document and are not to exceed 150 words for a master's thesis, or 350 words for a doctoral dissertation. This is not an arbitrary limit! If your abstract exceeds this word limit, the extra words will be cut during the ProQuest upload and your abstract will appear incomplete. The abstract page must be signed by the major professor(s) – it is the STUDENT’s responsibility to attain these signatures BEFORE the document is delivered to OI&GS (see Sample Format on page 18). The abstract is the last page using pagination in Roman numerals. If the thesis or dissertation is divided into manuscript style, the main abstract should be inclusive of all manuscript content included in the document. Each manuscript may include its own abstract, without a particular word limit. Likewise, the conclusion section should be a synthesis of all included manuscripts.

**Body.** For the body and the remainder of the manuscript, including text, charts, illustrations, appendices, bibliography, vita, etc., use Arabic numerals (1,2,3, etc.). Each page must be consecutively numbered. Do not use letter suffixes such as 10a, 10b. The numbering begins with 1 and runs consecutively to the last page of the paper. All page numbers should be at the right-hand margin at the foot of the page. Literature Review, Methods and Materials, Results, Discussion, and Conclusions are all part of the body portion of the document.

**Back Matter.** Bibliography, Appendices, and Vita or Resume are all part of the back matter portion of the document. Page numbering continues consecutively from the Body through the Back Matter section.

4. **Submitting the Thesis or Dissertation to the Office of Instruction & Graduate Studies (OI&GS):**

It is highly recommended that the student electronically submit one (pdf) copy of the thesis or dissertation for format review at least two weeks prior to the semester deadline for submission, and prior to making copies for binding. The draft copy of the thesis or dissertation will be reviewed by Suzette Vandeburg (svandeburg@esf.edu), the Assistant Dean, and returned to the student with comments. The Assistant Dean will review only the format, and not the content, of the complete document.

Before submitting your final thesis or dissertation manuscript to OI&GS, check to make sure you:

- Print your document on 8.5 x 11 inch paper, and it is printed on one side of the paper only. If you need to make your document double-sided, please check with the Assistant Dean (svandeburg@esf.edu, 227 Bray Hall) to discuss formatting issues before you begin composing your final document. Double sided printing requires use of “recto” and “verso” page formatting.

- Use no font size smaller than 10 point;
Use lines spacing no more condensed than double spaced.

Number pages in the lower right corner;

Have the abstract page signed by your major professor(s);

Have the title page signed by your major professor(s), chair of the exam committee, department chair, and Director of the Division of Engineering (ERE degrees only);

Include your vita/resume as the last page(s) of the thesis or dissertation. Include in Table of Contents;

NEVER copy formatting from someone else’s thesis or dissertation—it may not be correct.

Spell check all pages - especially the acknowledgment page;

Make sure all pages are included and in correct order;

Make sure you have not passed your delimitation date (If so, you must petition for an extension.);

Once formatting has been approved, and you have successfully completed all edits, convert the document to Adobe PDF format and submit it to ProQuest via instructions on the ProQuest website: http://dissertations.umi.com/esf/. The ProQuest copy does not need signatures; however, it must be an otherwise exact replica of the bound copy. This step must be completed as part of your degree requirements. ProQuest may charge a fee for this process, depending on your publishing choice, that can be paid online.

Candidates for the PhD degree a required to submit the Survey of Earned Doctorates. A PDF version of the survey can be found at: http://www.esf.edu/graduate/documents/SED11-12survey.pdf. The survey is designed to allow information to be typed into the form. However, once it is complete, students must print a copy and turn it into the OIGS office as the PDF cannot be saved. Please note the “Save via E-mail” function at the bottom of the last page does not work properly and the survey will not be saved.

Paper copies of theses or dissertations must be clear, neat, and legible, and free of any correction marks of any kind. Paper must be of good quality, 16lb. or 20lb. Weight (standard printer paper). Margins should be one inch around. Text is generally double-spaced, with font size no smaller than 10 point, and page numbering in the bottom right-hand corner. Students should verify preferences with their major professor and committee members. Remember, if you begin with double-space and convert to single-spaced, references within the text will require a universal upgrade (references to page numbers or tables, such as the table of contents).

Signed copies of the final, approved thesis or dissertation must be submitted [in a cardboard box, typically a copy center box or envelope box with a lid] to the Office of Instruction and Graduate Studies, 227 Bray Hall, in a quantity specified by the student’s academic unit, plus any
personal copies. With the exception of the title page, separate individual copies using colored sheets of paper. All title pages should be together on the very top for the Dean’s signature. Make sure the size of the box is not significantly larger than the size of the thesis/dissertation—otherwise, this could be problematic during transfer to the bindery.

5. Bindery Form

Required Number of Unbound Copies (boxed) to be delivered to OI&GS, 227 Bray Hall:

<table>
<thead>
<tr>
<th>Department (please check one)</th>
<th>Deliver this many unbound copies (in a stationery or letterhead box) to OI&amp;GS, 227 Bray Hall</th>
<th>Pay this amount (one copy remains unbound, so the amount in this column is the cost of binding all but one of the number of copies in the previous column)</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Environmental &amp; Forest Biology</td>
<td>2 (1 bound + 1 unbound for Moon)</td>
<td>$35</td>
</tr>
<tr>
<td>☐ Forest &amp; Natural Resources Management</td>
<td>4 (1 bound + 1 unbound for Moon, 1 bound for Dept., 1 bound for M Prof)</td>
<td>$105</td>
</tr>
<tr>
<td>☐ Chemistry*</td>
<td>4 (1 bound + 1 unbound for Moon, 1 bound for Dept., 1 bound for M Prof)</td>
<td>$105</td>
</tr>
<tr>
<td>☐ Landscape Architecture</td>
<td>2 (1 bound + 1 unbound for Moon)</td>
<td>$35</td>
</tr>
<tr>
<td>☐ Environmental Resources Engineering</td>
<td>4 (1 bound + 1 unbound for Moo, 1 bound for Dept., 1 bound for M Prof)</td>
<td>$105</td>
</tr>
<tr>
<td>☐ Paper &amp; Bioprocess Engineering</td>
<td>4 (1 bound + 1 unbound for Moon, 1 bound for Dept., 1 bound for M Prof)</td>
<td>$105</td>
</tr>
<tr>
<td>☐ Construction Management &amp; Wood Products Engineering</td>
<td>2 (1 bound + 1 unbound for Moon)</td>
<td>$35</td>
</tr>
<tr>
<td>☐ Graduate Program in Environmental Science</td>
<td>4 (1 bound + 1 unbound for Moon, 1 bound for Dept., 1 bound for M Prof)</td>
<td>$105</td>
</tr>
<tr>
<td>☐ Environmental Studies</td>
<td>4 (1 bound + 1 unbound for Moon, 1 bound for Dept., 1 bound for M Prof)</td>
<td>$105</td>
</tr>
</tbody>
</table>

Subtotal $ ____________________

Additional Bindery Fee(s) for Optional Personal Bound Copies

$35 each x _______ copies | Total fees due $ ____________________

*Department pays for binding three copies; student must submit at least four unbound copies.

The Department of Landscape Architecture requires students to include the following disclaimer in all theses:

The ideas and opinions expressed in this publication are those of the author and should not be interpreted as those of the State University of New York College of Environmental Science and Forestry.

Bound copies of theses and dissertations are distributed by the staff of the Office of Instruction and Graduate Studies. Students may request to have additional copies bound for personal use, but must pay $35.00 per additional bound copy. Copies of the document will be bound in green hard cover with gold
lettering. One paper copy and one bound copy will be deposited at Moon Library. The bound copy will be cataloged for circulation and the unbound copy will be archived in an archival box.

Theses and dissertations will be acceptable as first determined by individual departments. The student's selection of this format must be in keeping with guidelines established by each participating Department and have the prior approval of the student's major professor and steering committee.

This form can be acquired at: http://www.esf.edu/graduate/documents/GradBinderyFeeForm.pdf

6. Manuscript Format or Internship Report (approved by individual departments)

The “Title Page” should remain unnumbered, and all the rest of the front matter (i.e. the pages following the Title Page, and ending with the Abstract) should be numbered in lower-case Roman numerals, starting with “ii” at the bottom right-hand margin. The front matter should be ordered as shown below, so that the Abstract is the last page numbered with lower-case Roman numerals. The page following the Abstract, which is the first page of the body of the document (Chapter 1/Introduction), should start with page “1” and Arabic numerals should run thereafter until the last page of the student’s vita at the very end of the document.

Front Matter: Title page
Acknowledgments
Table of Contents
Abstract

Body: Introduction
Manuscripts
Conclusions

Back Matter: Literature Cited
Appendices
Vita or Resume

Non-print thesis or dissertation formats will be handled on an individual basis and the student selecting such a format, along with the supervising major professor and/or steering committee, should consult with the Library faculty early in the planning process so that all parts of the document can be accessed from the Library. Students shall submit a vita or resume (see suggested format on page 19) as the last page of the thesis or dissertation.

It is the student's responsibility to ensure that components of all submitted documents are in the correct order, with all pages included, and that title and abstract pages are signed prior to being submitted for binding. Changes made after the document is sent to the binder will be charged to the student.

Students who wish to register the copyright of their theses or dissertation may pay an additional fee to ProQuest to process the copyright application. A copyright page should be included within the manuscript
(see Sample Format on page 13) and inserted after the title page. The student is required to authorize the microfilm form and submit additional fees payable directly to ProQuest. For more information, see the ProQuest website.

7. Bibliography or References

The office of OIGS recommends that students follow the standard citation format used for journal publications in the student's field of study. The format must be consistent throughout the manuscript and placement of the bibliography or references should come at the end of the manuscript. Students may also opt to use the Council of Science Editors (CSE) style guide to format their references. Following are some examples of references in the name-year sequence of the CSE style guide. Please refer to the CSE style guide for more information.


*Print Citation Example taken from CSE Style Guide using the Name-Year Sequence:*

**Conference Paper:**

*The CSE style for citing journal articles on the internet includes:*
Author(s), Date of publication. Title of article. Title of journal (edition) [internet]. [date updated; date cited] volume (issue): cited pages. Available from: http: _____url (.doi: if available). It is also acceptable to cite electronic journal articles using the Bibliography or Reference style as long providing the electronic version is the same as the paper version.

**Example of a Web page/No Author Listed:**

Emerald Ash Borer (EAB) [Internet]. [updated]. Columbus (OH): Ohio Department of Natural Resources, Division of Forestry; [cited 2007 Jul 24]. Available from: http://www.dnr.state.oh.us/forestry/health/eab.htm

**Example of an Electronic Article:**

References


University Microfilms, Inc. Publishing Your Dissertation: How to Prepare Your Manuscript for Publication. [D-559D 35M 1993].

The above figure is an example of a thesis/dissertation title page.
© 2011
Copyright
A. M. Larkin
All rights reserved

Proper format of a Copyright page. No page number appears, but this is counted as page “ii” of the comprehensive document.
Acknowledgements

This work would not have been possible without the generous participation of Adirondackers and the technical support of the Adirondack Ecological Center at Huntington Wildlife Forest in Newcomb, NY. This research was supported by the Randolph G. Pack Environmental Institute at SUNY-ESF and the Edna Bailey Sussman Foundation. Kevin Prickett (Adirondack Park Agency) and Dan Plumley have been supportive individuals during my graduate studies and have taught me a great deal about the politics of the Park.

I would like to thank Dr. Colin Beier, for serving as my academic mentor. He has supported me, guided me, consoled me, and congratulated me along my graduate path. My committee members have likewise played crucial roles in the development of my research and this subsequent thesis: Dr. Valerie Luzadis, Myrna Hall, and Steve Signell. Finally, graduate life would be far less tolerable without the support of my peers and friends from the Quantitative Studies Lab and the Spatial Analysis Lab for Interdisciplinary Research.
TABLE OF CONTENTS

LIST OF TABLES ........................................................................................................ vi
LIST OF FIGURES ....................................................................................................... vii
LIST OF APPENDICES ............................................................................................... viii
Abstract .................................................................................................................... ix
CHAPTER 1: INTRODUCTION ................................................................................... 1
  OVERVIEW ............................................................................................................. 1
  CULTURAL HISTORY OF WILDERNESS ............................................................ 2
  PERCEPTIONS AND MAPPING ........................................................................... 2
  THE ADIRONDACK STATE PARK, NEW YORK ..................................................... 11
  THESIS SUMMARY .............................................................................................. 14
LITERATURE CITED ................................................................................................. 16

CHAPTER 2: WILDERNESS PERCEPTIONS AMONG COMMUNITIES IN THE
  ADIRONDACK STATE PARK, NEW YORK ......................................................... 20
  INTRODUCTION ................................................................................................... 21
    Wilderness and the Adirondack Park, New York ............................................. 25
  HYPOTHESES ....................................................................................................... 26
  METHODS ............................................................................................................. 27
    Study Area ......................................................................................................... 27
    Survey Instrument ............................................................................................. 30
    Data Analysis .................................................................................................... 33
  RESULTS ............................................................................................................... 35
    Survey Instrument ............................................................................................. 35
    Sample Population ............................................................................................ 37
    Wilderness Perceptions: Total Scores ............................................................... 39
    Wilderness Perceptions: Purism Scale and Distribution ................................. 42
    Wilderness Perceptions: Demographics and Other Descriptors ..................... 42
  DISCUSSION ......................................................................................................... 46
    Potential Management Implications ................................................................. 49
    Future Research ................................................................................................. 51
LITERATURE CITED ................................................................................................. 52

CHAPTER 3: MAPPING THE WILDERNESS PERCEPTIONS OF STAKEHOLDER
  GROUPS IN THE ADIRONDACK PARK, NEW YORK ........................................ 56
  Wilderness Legislation and the History of the Adirondack Park, NY .............. 60
  METHODS ............................................................................................................. 63
    Study Area ......................................................................................................... 63
    Survey Data ........................................................................................................ 64
    Mapping ............................................................................................................. 65
  Comparisons of Perceived and Legislated Wilderness .................................. 74
  RESULTS ............................................................................................................... 75
    Map Extent and Total Area ................................................................................. 75
    Perceived and Designated Wilderness ............................................................. 80
  Implications for WILDERNESS and Management in the Adirondacks .......... 89
CHAPTER 4: CONCLUSIONS .................................................................................. 94
  VALUE OF COMBINED METHODS .................................................................. 94
  WILDERNESS PERCEPTIONS IN THE ADIRONDACK PARK ....................... 95
  IMPLICATIONS OF THIS RESEARCH .............................................................. 96
LITERATURE CITED ............................................................................................... 98
RESUME .................................................................................................................. 124

Proper format for a Table of Contents, listing only the sections of the document that appear AFTER the Table of Contents (i.e., omitting the Acknowledgements, Copyright, and Table of Contents). The Table of Contents should be formatted in Word, with page numbers aligned to the right and page leaders between the headings and page numbers. See the following page for instructions on constructing a Table of Contents in Word 2007.
A Table of Contents can be constructed in Word based on a pre-existing document with headings and subheadings. Insert the cursor at the start of the document, or where you intend the Table of Contents to appear. In Word 2007, navigate to the References tab, select Table of Contents, Automatic Table 2. This will insert a blank Table of Contents, as seen below.

Next, select content to add to the table by highlighting various headers and using “Add Text” under the References tab. Here, you can define the levels of text, which corresponds to the indentation and order in the Table of Contents. You will have to “Update Table” after you “Add Text.”

Word will typically reformat your document text once you “Add Text.” You can either reformat the text within the document, or reformat the style for the document under Home tab, Styles, then select each layer of text (e.g., TOC 1, TOC2, TOC3, etc.) and select Modify. Here, you can set the text to a specific color, size, or format (bold, italics, capitalized). You can also edit text appearance within the Table of Contents.

Each time you Add Text to the table, or change the page location of a heading, you will need to update the table by clicking on the Table of Contents.

For more information on setting up a table of contents, visit:
Formatting a List of Figures and List of Tables is a similar process, but through different options in Word 2007. First, you must designate the number and description of each table/figure as a Caption. Select the table or figure then under the References tab, select Insert Caption. In the space provided, enter the description of the table or figure. It is likely that Word 2007 will reformat your text, but you can define the format within the Home tab, styles, captions, then modify.

To organize tables/figures by chapters, you can either use a precise numeric or you can create new, specific labels for the tables and figures of each chapter within Insert Caption. You should create captions before you insert the Lists. Once you have entered all the captions, you can create Lists for Tables and then Figures, or organize each of those lists by chapters. Tables are updated by selecting Update Table from the Captions section on the References tab. A similar List can be created for Appendices, if the end of your document contains multiple Appendices.

The List of Tables, List of Figures, and optional List of Appendices are the first items to appear in the Table of Contents. Throughout all tables, remove any optional hyperlinks and use page leaders

For more information, visit:


Example List of Tables, organized by chapters. List of Figures and List of Appendices are similar.
Wilderness can be understood via individual perceptions that may contrast with legal definitions. This contrast was explored within the Adirondack Park (NY), a unique combination of land uses and stakeholders with a history of conflict over policies that restricted development to conserve natural resources. This research used wilderness perception mapping (WPM) to identify differences between perceived and legal wilderness in the Adirondacks, based on the desirability of landscape characteristics (e.g., maintained campsites) reported by questionnaires. I used this approach to gain insights on differences among stakeholders and communities, and to construct maps of wilderness perceptions to compare with existing land use classifications. Survey and map analyses indicated clear differences among stakeholders, particularly between residents and non-residents, and between legally designated and perceived wilderness areas. These insights contribute to a greater understanding of diverse stakeholder groups and improved management of the Adirondack Park landscape and natural resources.

The maximum acceptable length for an abstract to be published in Master’s Thesis Directories is 150 words, and the maximum acceptable length for a dissertation to be published is 350 words. Proquest will only accept the online submission of abstracts at this word maximum, and will omit any additional words. It is in your best interest to maintain this maximum. You can prepare more lengthy abstracts within each document chapter.

Key Words: stakeholder groups, Adirondack communities, purism scale, geographic information systems.

A. M. Larkin
Candidate for the degree of Master of Science, April 2011
Colin M. Beier, Ph.D.
Department of Environmental and Forest Biology
State University of New York College of Environmental Science and Forestry,
Syracuse, New York
Colin M. Beier, Ph.D. ___________________________________________ ix

For Co-major professors, list both names and include signature lines for each individual
CHAPTER 1: INTRODUCTION

OVERVIEW

Wilderness designation and preservation is based on current legal policy that defines the wilderness concept. An alternative understanding of wilderness can be gained via individual or cultural perceptions. The Adirondack State Park of New York provides an ideal environment for the study of wilderness perceptions, with a six million acre mixed landscape of public and private lands and a history of conflict between residents and nonresidents over the use of Adirondack lands and resources. Wilderness perception research in the Adirondack Park could improve the understanding of differences among stakeholders and assist managers and policymakers seeking to balance conservation and development in this unique wilderness landscape.